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1 Preface

XtreemMachine® is a truly high-powered telecommunications software program. If
you have any questions or suggestions about the program or the manual, please do
not hesitate to contact us:

Diamond Multimedia
610 Wharfedale Road, Winnersh Triangle
Wokingham, Berkshire, RG41 5TY, UK

Support: +44-1189 4444-44 (Tech Support)
Fax: +44-1189 4444-01

BBS: +44-1189 4444-15 (V.34 modem)

Internet: http://www.diamondmm.de
ftp://ftp.diamondmm.de

www.diamondmm.de
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2 General Information

This manual is designed to give you a quick introduction to XtreemMachine®. How-
ever, it only describes the most important XtreemMachine® functions so that you can
start working with the program as quickly as possible.

This manual makes use of certain conventions. All menu items are represented by ita-
lics and an arrowhead sign, e.g. File→ Exit. All texts related to dialog menu windows,
including buttons, check boxes and entry fields, are printed in italics, e.g. Cancel.
Names of dialogs, such as Answering Machine Settings, are also identified typo-
graphically. References to icons, such as the Help icon shown on the left, are printed
in boldface type.

The complete function set, as well as a great deal of background information on 
XtreemMachine® and telecommunications, can be obtained by calling the Online Help
function.

XtreemMachine® offers you every option currently available in the telecommunica-
tions field. It allows you to use your computer as a universal answering machine, fax
machine, BBS (Bulletin Board System) and as an Internet gateway. It also provides a
wide array of functions far beyond the capacity of most equipment commercially 
available today.

Because of its versatility, XtreemMachine® is an ideal application program for both
business and private use.

Before you run the installation program we would like to present some information
from the world of telecommunications that may prove useful to beginers.

A ”modem“ (modulator/demodulator) is a piece of equipment that transmits data
between computer systems via a telephone line. In addition, modern modems can
also be used as answering machines (for voice data) or as fax machines. To ensure
smooth operations, XtreemMachine® has to know what modem you are using. It will
then automatically recognize your modem during the Setup process and configure
XtreemMachine® to suit your exact needs.

A modem is connected either directly to a telephone subscriber line or to a PABX 
(private automatic branch exchange) extension. The Setup program will automatically
check which option you have chosen. When connected to a PABX extension, you

Basic terms

Modem

Telephone
connection
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must prefix the phone number with a special digit in order to obtain an outside line.
The Setup program will check this for you, too.

By ”dialling method“ we mean the way a telephone (and, of course, a modem) sets
up a connection with another party. There are two basic methods of dialling: pulse
dialling and tone dialling, or DTMF (Dual Tone Multiple Frequency). Pulse dialling,
which until a few years ago was the only dialling method used in Germany, can be
recognized by its relatively loud series of clicks. It works in virtually all local telephone
networks. Tone dialling is more powerful and is expected to replace pulse dialling
altogether. You can recognize it by the high-pitched beeps you hear in the receiver
when you enter a number on a push-button telephone. When installing a system for
the first time, try tone dialling first. If you can not establish a connection, switch to
pulse dialling. The dialling method you need will be determined and installed by the
Setup program.

Every faxing device has a unique identification code, or fax ID. Normally, this is the
phone number of the fax connection, written in standard international format. For
the United States, for example, you first enter +1 for the country code, followed by
the three-digit area code and then the telephone number. A typical American fax
number thus looks as follows:

+44-1189 4444-01

XtreemMachine® gives you the additional option of adding letters to the fax ID. Thus,
Diamond’s fax number in Germany might look something like this:

Diamond Multimedia, Germany - +49-8151-266-200

Fax ID

Dialling method



3 Installation

3.1 Hardware and Software Requirements

Before installing your system you should make sure that your computer meets the fol-
lowing hardware and software requirements:

Processor 80386DX/40 MHz or higher
Disk storage at least 10 MB
RAM at least 4 MB
Voice modem Diamond SupraExpress 336e Sp

Diamond SupraExpress 336e eV+
Diamond SupraExpress 56e 

Operating system MS-DOS 3.3 and higher
Windows version MS Windows 3.1, 3.11, Windows 95, 

WindowsNT 4.0

These figures are minimum requirements. XtreemMachine® works much faster on
more powerful computers.

The disk storage requirement refers to the amount of space actually occupied by the
program on your hard disk. You should have a few extra megabytes of free space
available for voice messages, which take up quite a lot of space.

To make XtreemMachine especially convenient and easy-to-use, we recommend in-
serting a Windows-compatible sound card such as Soundblaster or similar models.

3.2 The Setup Program

First, insert the CD into your CD-ROM drive. Then start the Setup program by selec-
ting File→ Run from the menu of the Windows program manager and entering the
following line:

a:\setup (if you are using drive A)
or
f:\setup (if you are using drive F)

Installation3
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The Setup program will now start and you will see the following screen:

If you want to proceed with the installation, select the Continue button. During
installation you will have to enter the following information:

your name

your fax ID

When installation is complete, the Setup program will have configured
XtreemMachine in the best possible way for your computer. XtreemMachine is now
completely ready to operate. During installation, you will be asked whether you want
to install the fax driver. If you don’t do this, you will not be able to send faxes directly
from other Windows applications.

Installation3
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4 Getting Started

4.1 Running the Program for the First Time

When installation is complete, select the kik control icon from the
”XtreemMachine“ program group and give it a double-click with the mouse. This
starts the main XtreemMachine® program.

Once the program has started, the following screen will appear:

The XtreemMachine® welcome window has three built-in sample objects identified
by special symbols.

BBS message

fax document

voice message

Getting Started4
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Special icons have been provided so that you can bypass the menus to reach the most
important functions directly. To work even faster, you can activate the icons by 
pressing combinations of keys. For example, CTRL+H means that you should hold
down the CTRL key and then press the H key.

Open Online Help service (F1)

Start operator (CTRL+H)

Start terminal (CTRL+T)

Access America Online (AOL)

Access T-Online

Access CompuServe

Access Internet

Start own program (CTRL+R)

Call (F5)

Play all new messages (F2)

No new messages received (F2)

Open Inbound window (F2)

Open Outbound/Events window

Open Archive window (F3)

Getting Started4
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View fax or mail or play voice file

Send fax or voice file (CTRL+S)

Record voice file (CTRL+A)

Print fax (CTRL+D)

Delete mail, fax or voice message (DEL key)

For quick information on the meaning of an icon, move the mouse arrow to the icon
and leave it there for a moment. A small window will appear explaining the icon’s
function.

4.2 The Answering Machine

4.2.1 Playing the Sample Greeting Announcement

If you want to hear the sample greeting announcement message, select the
Settings→ Answering Machine menu. The dialog menu window for the answering
machine will appear:

Getting Started4
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Now click the Play button to hear the sample message.

4.2.2 Recording New Greeting and Sign-off Announcements

The sample basic announcements are contained in entry fields of the dialog menu
window for the answering machine, e.g.:

Recording On  ANSAGE1.RVD

To change these announcements, select the corresponding entry field and enter
the file name for your announcement. Then confirm your entry by pressing the
Record button.

XtreemMachine® now goes into record mode and opens the VoiceRecorder win-
dow:

Once again, select the Record button in the dialog menu window shown above.
You may now speak your announcement into whatever recording medium you
have available, e.g. a sound card microphone or a microphone built into your loud-
speaker.

Having done this, you should play back your announcement to check its volume
and intelligibility by clicking the Play button. Repeat this procedure until you are
satisfied with the results. Then click the Save button to save your text to hard disk.

The volume regulator only raises the playback volume on the sound card. It has no
effect on the sensitivity of the microphone. This also applies to the use of the
modem loudspeaker.

Recording your
own announce-

ments

Checking your
announcement
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The procedure described above for recording your own greeting announcement
applies to all basic announcemnts. Unlike many mechanical answering machines,
sign-off announcements are not mandatory.

The beep tone is a special case. If you leave this entry field blank, the standard beep
will be played to prompt the caller to leave a message. Use this entry field to enter a
sound of your choice instead of the standard beep.

Various standard announcements are used, depending on how you configured your
system:

Recording On Greeting announcement requesting caller to leave a message.
Recording Off Greeting announcement presenting information only.
Beep Tone Standard beep since no entry exists.
Message Over Sign-off announcement played back after a lengthy pause.
Message Timeout Recording time has expired.

The dialog menu window also displays the maximum recording length per call and
the maximum length of the pauses. If a caller stops talking for longer than the time
specified, XtreemMachine® will assume that the call is over and will hang up.

Maximum Length Maximum length of recording in seconds.
Maximum Pause Maximum length of speech pause in seconds.

These defaults are mean values that have proved their worth. However, you may raise
or lower them as you see fit.

4.2.3 Deleting announcements

To delete standard announcements, select the Messages window in the Outbound→
Voice Messages menu:

Getting Started4
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Then select the announcement you want to delete and click the Delete icon.

Do not delete the standard announcements as the XtreemMachine must always be
able to default to them if no other messages are defined.

If you want your PC to be able to take calls you have to start the operator. It works
completely independently of the other program units, which means that it remains
ready to receive even after exiting the XtreemMachine®. You can start it either in the
Windows program manager or by clicking the XtreemMachine® operator icon. The
operator manages all the call processing facilities of your modem completely by itself
(see also the ”Operator“ section of this manual).

4.2.4 Composing Greeting Announcements

When you create your greeting announcement, be friendly to your callers, but do not
forget to give them a few basic items of information:

Tell them that your answering machine is switched on. XtreemMachine’s quality of
reproduction is so high that some people will think you’re actually on the phone!
State your name, or at least your phone number, so that your callers will know that
they have reached the right number.
Make your greeting as friendly as possible. Encourage your callers to leave a message.
Indicate whether it is possible to leave a message. Avoid long pause.

4.2.5 Listening to Inbound Calls

XtreemMachine® enters inbound calls in the Inbound window. You can call them up
at any time by clicking the Play New Messages icon. If you only want to listen to one
call from the list, mark it with the mouse and then click the Play/View icon.

Getting Started4
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4.2.6 Selecting Different Greeting and Sign-off Announcements

Sometimes you may need different greeting or sign-off announcements for different
situations. For example, you might want to say ”You can reach me under the number
.....“). If so, simply repeat the recording procedure until you have all the announce-
ments you need.

When you do this, make sure that the files have different file names. To enter a new
announcement, place the cursor on the item you want to change in the Answering
Machine dialog menu window and click the Select button:

Now select the desired announcement from the list and confirm it by clicking OK. If
you want, of course, you can always enter the name of the file directly.

4.2.7 Toggling the Record Facility

You have the option of switching (”toggling“) whether or not the caller is allowed to
leave a message. XtreemMachine ® will automatically switch to the right greeting
announcement. Toggling takes place in the dialog menu window marked More
Options, located in the Answering Machine dialog menu window:

Getting Started4
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4.2.8 Toggling the Answering Machine

To switch off the answering machine, cancel the Answering Machine Enabled check
box in the More Options dialog menu window. The mark will disappear, and your
answering machine is programmed as being switched off. To reactivate your an-
swering machine, select the check box again. 

For the moment, your answering machine is only programmed as being switched off.
This means that no fax calls or mail can be received. However, it is possible to reac-
tivate your machine by remote control (see the ”Remote Control“ section).

4.2.9 Setting the Number of Rings

Another option is the number of times the answering machine will ring before
answering the call. To set this number, select Answer Options in the Settings menu.
This will open the Answer Options menu window:

Getting Started4
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Place the cursor on the items you want to change and enter the new values. Two set-
tings are especially important at first. Normally a call will be answered when the num-
ber of rings defined in the Answer After entry has been reached. If new inbound mes-
sages have been received, XtreemMachine® will use the value defined under New
Messages Present. The other settings are explained in the sections below.

It is always a good idea to make the ring setting in the Answer After entry larger than
the New Messages Present setting. This will enable you to determine by remote con-
trol whether any new messages for you have arrived, but without having to pay tele-
phone fees. If your answering machine does not answer your call after the number of
rings specified under New Messages Present, there are no new messages and you can
hang up.

4.3 Fax

4.3.1 Sending a Fax

Once XtreemMachine® has been installed it is fully ready for operation. If you want to
send a fax immediately, write your text with a Windows application (e.g. MS
Windows Write). To send the text, select the File→ Print menu in the application and
choose XtreemMachine as the printer. Now start the print process as you would nor-
mally do. This opens the dialog menu window for sending faxes:

Getting Started4
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Enter the number of the fax you want to dial in the Fax Number entry field, or click
the Phone Book button to select a number from the list of entries there.

The Attempts and Intervals entries are used to enter the number of attempted calls to
be made and the period of time between attempts. Once you have entered the fax
number and confirmed it by clicking the Send button, the fax will be sent.

After installation, the phone book contains a single default entry.This is followed by
nine empty group entries which you can use to enter as many new numbers as you
want for the group fax function.

If you want to add new numbers, click the New button and enter the name, phone
and fax number you want to add:

Getting Started4
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Confirm your entries by clicking the Save button. The same method is used to Modify
or Delete entries.

Activate the Internal box when the phone, fax or BBS number you want to save is an
extension in your own in-house telephone system. XtreemMachine® will then auto-
matically know which dial prefix to use.

To assign the specified new party to a group for the group fax function, here is what
you do:

First, mark the group you want the newly specified number to be assigned to. Then
click Modify. The following window will appear:

Getting Started4
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The window on the left, Not In Group, contains a list of all previously specified fax
numbers. Now mark the number (or numbers) you want to assign to the group and
click  > for each separate number, or >> for all the numbers you marked.

If you did not install the fax driver during XtreemMachine installation, proceed as
described in the Installing the Fax Printer Driver help text and install the driver.

4.3.2 Receiving a Fax

When a fax arrives, an entry is made for it in the Inbound window. Mark the fax you
want by selecting it with the mouse. Now start the FaxViewer by clicking the
Play/View icon or double-clicking the entry with the mouse. The FaxViewer window
will appear:

Getting Started4
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The icons in the FaxViewer enable you to change the screen display of a page or to
scroll forward or backward in the fax document. They also allow you to print or dele-
te the document. For more detailed information see the ”FaxViewer“ section.

4.4 The BBS (Bulletin Board System)

4.4.1 Changing the „SYSOP“ User Password

Once you have installed XtreemMachine® it is advisable to change the password of
the SYSOP user. SYSOP is a default user equipped with all rights and privileges. By
changing the SYSOP password you prevent unauthorized users from damaging your
BBS. Proceed as follows: First, open the BBS item in the pull-down control menu. The
following window will appear:

Now click Start BBS Offline. This opens the kik XtreemMachine - bbs window:

...

Getting Started4
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Select the Settings→ Users menu. The User Administration window will appear:

Click the Modify button. Another window will appear. Place the cursor in the
Password entry field and enter your password:

Getting Started4
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4.5 Terminal

The terminal program allows you to set up data connections, for example, to other
XtreemMachine® users or BBS mailboxes. Start the program by clicking the correspon-
ding icon:

The program will set up a data connection to a remote party and display the received
data on your screen. Until the connection is established, your screen will be empty.

Getting Started4
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4.5.1 Setting up a Data Connection

To set up a data connection, click the Dial icon. The Dial window will now ask you to
enter the name of the party you want to call and the phone number you want to dial:

Start dialling by clicking the Dial button:

Once the connection is set up, a message to that effect will appear on your screen
and you can start exchanging data with the BBS you have dialed.

4.5.2 Sending and Receiving Files

The terminal program enables you to transmit files from your computer or to receive
them from other systems. Transmission protocols such as XModem or ZModem are
used to ensure that the files are transmitted properly.

To send a file wait until you are prompted to send the file by the answering party.

Getting Started4
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Then click the Send File icon. The Send File window will appear:

Enter the name of the file you want to send, making sure to select the right transmis-
sion protocol, i.e. the one used by the answering party (usually ZModem). The trans-
mission process will start when you click the Send button.

To receive files from other systems, select the files in that system and wait for the
answering party to request that you start your transmission procedure. Now click the
Receive File icon:

Once you have selected the right transmission protocol, click the Receive button. The
file will now be transmitted.

4.5.3 Clearing Down a Data Connection

To clear down a data connection at the end of a session, select the Hang Up icon.
Your modem will hang up, terminating the connection. 

Getting Started4
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When you have familiarized yourself with the functions in this section, the basic
XtreemMachine® functions will have beeen adapted to suit your user environment.

4.5.4 Script Function

A detailed description and explanation of the script function can be found in Online
Help.

Getting Started4
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5 Structure and Operation

5.1 The Structure of XtreemMachine®

XtreemMachine® consists of five program units. The task areas of each of these units
is outlined in the sections below.

5.1.1 „Control“ - the Main Program

One of the tasks of the main program is to list all inbound messages (voice messages,
faxes and mail) and to process them further. For playing voice messages it may, op-
tionally, make use of the sound card or your modem’s loudspeaker. For displaying
and printing fax documents or mail, it starts the FaxViewer or a text editor. Another
important task is to issue jobs to the operator, e.g. ordering it to send a voice mess-
age or to call another telephone subscriber. Finally, the main program manages the
configuration of the entire system, including the settings for the modem, answering
machine and the fax or BBS facility.

5.1.2 The Operator

The operator takes charge of controlling the modem for both inbound and outbound
calls. It is also capable of running several default settings very quickly. With its small
main window and low RAM requirements, it is ideally suited for continuous back-
ground monitoring of the telephone line without impairing your work in progress or
system operations.

5.1.3 The Built-in BBS

The operator starts the built-in BBS whenever it recognizes an inbound BBS call. The
BBS allows callers to leave messages or to send files. It can also be called offline, i.e.
without a modem connection. This mode is useful if you want to test your settings.

5.1.4 The Terminal Program

You need to use the terminal program if you want to set up connections to mailboxes
(e.g. the XtreemMachine ® built-in BBS) from your computer. This program sets up a
data connection, displays all received characters on the screen and sends your key-

Structure and Operation5
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board input to the answering party. To ensure error-free file transmission, it provides
you with the file transmission protocols mentioned above.

5.1.5 The FaxViewer

The FaxViewer is responsible for displaying and printing inbound fax documents. It is
also capable of converting fax documents into graphics files, allowing them to be edi-
ted further.

5.1.6 The Fax Printer Driver

The fax printer driver enables you to fax a document from any application by means
of a simple print operation. You can also use it to create documents on fax polling or
fax-on-demand.

5.2 Operation

In operation, XtreemMachine® behaves like any other Windows program. In creating
the menu toolbars, care was taken to place items in their customary positions. 

5.2.1 Window Types

In the main window XtreemMachine® displays three different types of sub-windows.
List windows contain entries, voice messages, fax documents and mail. The Welcome
Message window and Inbound window look as follows:

The color of the entry tells you whether the file is new or old, i.e. whether you have
already heard or seen it. New files appear in red lettering, old entries in black.

Fax printer

Inbound 
window
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Entries in the Outbound/Events window are timed events such as the sending of a fax
document. You can open the window via the Outbound→ Outbound/Events menu
item:

Further information on processing events in Outbound windows can be found in the
”Events“ section.

The Archive window is opened via the Inbound→ Archive menu item:

It lists messages and information on program execution, letting you know which op-
eration XtreemMachine® performed at any given time. Further information can be
found in the ”General Settings“ section.

5.2.2 Editing Messages, Fax Documents and Mail

To process voice, fax or mail files, select the entry of the file you want to process in
one of the list windows (e.g. Inbound, Outbound/Events or Archive). Then perform
the desired operation (e.g. deletion) by selecting the corresponding menu item (File→
Delete) or by pressing a key or combination of keys (in this case the DEL key). You can
also click the icon assigned to the operation, i.e., in our example, the Delete icon.

5.2.3 Changing a Description

Every voice message, fax document or item of mail has a description. This description
is displayed in one of the list windows at the end of the entry concerned.
XtreemMachine® generates the text automatically whenever a file is created. The text
provides information on what led to the file being created. If you want to change this
text, mark the entry and select the Edit→ Comment menu item:
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Now enter the new text and close your entry by clicking the OK button.

5.2.4 Archiving Files

XtreemMachine® administers an archive. You can open this archive by selecting the
Inbound→ Archive menu item and use it for storing voice messages, fax documents
and mail. 

If you want to archive a file, mark the entry for that file and select the Edit→ Send To
Archive menu command. The entry will disappear. The file is now in the archive.

5.2.5 Changing the Old/New Mark

If you want to change the ”old“ or ”new“ status of a voice message, fax document
or item of mail, select the Edit→ Toggle New/Old menu item. This will change a new
file to an old one, or vice versa.

5.2.6 Viewing Directory Contents

To view the contents of a directory as quickly as possible in the XtreemMachine win-
dow format, select the File→ FileViewer menu item:
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Now select the directory you want. Its contents will be listed on the screen, and you
can edit the entries in the display window with the usual commands (e.g. Delete,
Play/View).

5.2.7 Starting the Internet

A click on this item will start either the Microsoft Internet Explorer or the Netscape
Navigator. If you are not connected to a network, an Internet service provider can
help you set up an Internet gateway via a telecommunications network.

5.2.8 Starting a Program

The Start Program icon (or File→ Start Program menu item) enables you to run any
program both from the main program and from the operator:
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This has the advantage that when you enter the program you can tell Xtreem-
Machine® that the program needs to use the modem. The operator will then release
the modem automatically before the program is run, thereby making it available to
the other application.

You can enter programs in the System Settings dialog window, which is selected via
the Settings→ System Settings menu. Further information can be found in the
”General Settings“ section.



6 The Answering Machine

In the ”Getting Started“ section, you already learned how to change and use the
basic answering machine functions. There are two standard messages which are 
played back depending on whether the caller is or is not allowed to leave a recorded
message.

But there is more to the XtreemMachine® answering machine than that. This section
tells you how you can give a caller the opportunity to query messages and to control
your answering machine or computer. It also tells you how to employ different 
announcements at different times.

Many settings can be changed over the telephone. Further information can be found
in the „Remote Control“ section.

6.1 Answering a Call

XtreemMachine® has different ways of answering inbound calls. You can configure
the method you want in the Answer Options dialog menu window, which is reached
via the Settings→ Answer Options menu.

The start of the answering machine is set by default. Note that fax or BBS calls will
also be answered in this setting. Even in answer call mode, XtreemMachine® is cap-
able of switching automatically.

By setting Fax or BBS/Fax you can have calls answered directly as fax or BBS calls. It is
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also possible to link a caller directly with the fax-on-demand system without involving
the answering machine. For further information on this subject, see the ”Fax-On-
Demand“ section.

In order to solve possible problems or to distinguish more quickly between voice, fax
and BBS calls, you can activate the DataSwitcher before starting the answering ma-
chine or the fax-on-demand system.

6.2 DataSwitcher

Normally it is not necessary to use the DataSwitcher to answer and classify calls. The
answering machine’s detection mechanism is sufficient for most purposes.

The XtreemMachine® DataSwitcher is a very special function that can be activated for
the purpose of handling data calls from older fax machines or modems.

The way the DataSwitcher works will become clear if we take a closer look at what
happens when a call arrives. When a call is received, the answering machine starts up
after a certain number of rings. If the inbound call is a voice call, the caller leaves his
or her message after the welcome message has been played. If it is a data call, the
calling device sends a specially defined tone, letting XtreemMachine® know how to
respond. In such cases, there is no need to activate the DataSwitcher.

However, there are instances where the calling device does not identify itself with a
tone. In such cases, the call cannot be immediately and unambiguously classified. The
program assumes that it is a voice call, and responds accordingly.

The DataSwitcher (Settings→ Answer Options; see above) solves such problems by
playing a short message to provoke a response from a human caller. For example, a
human caller will usually say something in response to an inquisitive „Hello?“ (default
message), thereby revealing that the inbound call is a voice call. If there is no re-
sponse, XtreemMachine® will assume that a data call has arrived without a preceding
signal tone. Some very old fax machines - and practically all non-certified modems -
lack the feature of sending an initial beep for identification purposes.

To change the DataSwitcher announcement, select the Settings→ DataSwitcher
menu. The following window will appear:
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Here you can change the message as usual by clicking the Record or Select button
and either recording a new announcement or selecting an existing one from the list.
You can also change the detection period under Wait For, but this should only be
done in exceptional circumstances.

6.3 Variable Announcements

By ”variable announcements“ we mean the option of having the answering machine
play different prerecorded announcements at different times. For example, your
announcement from Monday to Thursday between 8:00 am and 1:00 pm might read
”You can reach me under the number ...“ and at all other times ”You can leave a
message after the beep.“ You can also record two or more announcements to be se-
lected at random for playback.

To make these entries, click the Variable Messages button in the Answering Machine
dialog menu window. The following menu window will appear:

The Answering Machine6

66



Select the weekday or weekdays on which you want the announcement to be played.
Then enter the time of day (note the predefined format). Continue by selecting an
announcement, either by clicking the Select button or by entering a file name. You
can now record a new announcement. If you want to enter two or more announce-
ments, specify them here, separated by semicolons.

By clicking the Record check box you can define whether the caller is allowed to leave
a message or whether the system should only play back the prerecorded announce-
ment.

6.4 Preparing Private Messages

The XtreemMachine® Private Messages function makes it possible for a caller to hear
a message especially meant for him or her. It can, of course, also be used to present
messages of general interest.

Enter the message in the Answering Machine menu window by clicking the Private
Messages button and either selecting an existing text or recording a new one:
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Now, using the DTMF Tones entry field, assign a DTMF code number to the private
message you have selected. (Further information on DTMF tones can be found in the
Online Help service under ”DTMF.“) The code number may be up to ten digits long.

Choose a longer code number if the message is meant to be private, and send the
number to the person for whom the message is intended. If the message is meant for
all callers, the code number should be as short as possible. Moreover, the normal
message should contain a remark to the effect that further information is obtainable.

If the caller wants to hear this message, he or she has to enter the DTMF code num-
ber during the message or speaking period, using a DTMF transmitter (e.g. a remote
control transmitter on a normal answering machine) or a touch-tone telephone. Once
this is done, the message will be played. The Recording Permitted check box lets you
give the caller an opportunity to leave a message even if the record message facility
has been switched off in the More Answering Machine Options menu window.

6.5 Delaying the Start of the Answering Machine

If you happen to be at home but not in the immediate vicinity of your computer, it is
sometimes useful to delay the start of the answering machine. For this purpose
XtreemMachine® offers the User At Home function (see the More Answering Machine
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Options menu window). You can quickly toggle this function by clicking the User At
Home button in the operator. This raises the number of rings before the call is answe-
red (see Answer Options menu window), after which the Paging function is started.

6.6 Paging

The Paging function enables callers to tell you that they urgently want to speak to
you. When a call arrives while User At Home is on, paging is activated automatically.
Otherwise, the only way to start the function is for the caller to enter a DTMF code
number while the greeting announcement is being played or while his or her message
is being recorded.

After paging has been started, the Welcome message will tell the caller that the pro-
gram is trying to reach you. At the same time, XtreemMachine® will let you know
through the Local Message beep that a call has arrived and that you can answer it:

Meanwhile, the caller hears the On Hold message. If you fail to answer the call during
the maximum hold period, an Apology will be played and the answering machine
restarted.

To change the texts and the hold time, click the Call Waiting button in the Answering
Machine menu window:
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6.7 Forwarding Inbound Calls

You can have XtreemMachine® forward inbound calls. In this case, it will dial the
numbers you specify and play you the messages recorded on your answering ma-
chine. To activate this function, click the Callback button in the Answering Machine
menu window:

Using the relevant entry fields in the timetable, enter the days and times when you
want callback to be activated. Now specify (or select from a telephone list) the Phone
Numbers to which you want your calls to be forwarded (see also the ”Remote
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Control“ section). Inbound calls will now be forwarded to the telephone where you
happen to be at the given time. If you don’t want to make use of the time control
feature, enter a generally applicable phone number in the At Other entry field.

It is also possible to specify a Callback Password making you the only person allowed
to take these messages. After dialling, you will have to enter this password (via a
DTMF transmitter) to hear the messages. If you decide not to define a password, play-
back will begin immediately after dialling.

If the Ringing Tones Before Cancellation is reached during a callback operation,
XtreemMachine® will terminate the attempt. This process is repeated until the predefi-
ned number of attempts is reached.

This function can be toggled by marking the Callback Enabled check box. However, it
is faster to use the Toggle Callback button in the Operator.

6.8 Running Programs on the PC

XtreemMachine® gives you the option of running programs by remote control (see
also the ”Remote Control“ section).

This function can be useful, for example, for collecting measurement data from a PC-
supported long-term experiment. To check your data on the weekend, all you need is
a program that will fax your measurement data to XtreemMachine®. You can then
start the program by remote control and collect your data (see also ”Fax-On-
Demand“ section).

The program call-up settings are made in the Program Calls menu window, which is
reached by clicking the Program Calls button in the Answering Machine menu win-
dow:
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This window can be used to define up to five different program calls. By marking the
Active check box you can quickly select or clear each program without deleting the
settings. You can call-up a program only if the entry has been activated. To make the
other settings, click the Settings button for the program you want:
If the Program Call Code entry field is empty, the program can only be run by remote

control. The Program Call entry field must contain the name of the program you want
to run, including a complete path description, if necessary.

The Voice Description entry filed should contain a recorded message identifying the
program to be run by remote control. This file is recorded in the usual way.
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You have the option of defining how XtreemMachine® will behave when it starts a
program. You can make XtreemMachine® wait until program execution is completed.
In this case, the main program will stop and will not resume until the remote program
has finished. It is also possible to release the modem.

You can also have a data connection set up before the program is run. The speed of
the modem/computer can be set. After the program is called up, the caller must
switch his or her modem over to the telephone line, otherwise there will be no way to
set up the data connection.

You can also specify whether XtreemMachine® should hang up before the program is
called up, after it is called up, or never. If the latter, the session will continue. This
function enables you to run two or more programs in a single call, if desired.

Please read the detailed discussion of this subject in the Online Help service. You can
call it by clicking the Help button in the dialog menu window.

6.9 Other Answering Machine Functions

In addition to private messages and program calls, there are other functions that can
be run by entering DTMF tones. You can find the settings of the DTMF sequences in
the DTMF Tones dialog menu window, which is reached by clicking the DTMF Tones
button in the Answering Machine Settings menu window:
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The most important DTMF tones for remote control are:

Cancel Message Terminates playback of the answering machine’s 
greeting announcement message and jumps directly
to record message facility.

Start Remote Control Starts interrogation by remote control (the relevant 
functions are explained in the ”Remote Control“ 
section).

Call Waiting Starts the paging function (see above).

Receive Fax Introduces manual fax reception. Useful for devices 
that have to place a normal call before a fax can be 
sent by pressing the machine’s start key.

Start Fax-On-Demand Starts fax-on-demand, i.e. the polling of prepared fax 
documents (further information can be found in the 
”Fax-On-Demand“ section).

Some of the DTMF tone settings (e.g. remote control and fax-on-demand) may also
be entered in other dialog menu windowes.

6.10 Overview of DTMF Tone Settings

To obtain an overview of the current DTMF tone settings, select the Settings→
Generate DTMF Tones Report menu item. XtreemMachine® will then generate an
item of mail in which the current settings are listed. This mail item is displayed in the
Inbound window, where you can read it in the usual way.
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7 Voice Functions

XtreemMachine® offers several voice functions not directly related to the answering
machine.

7.1 Calling by Phone

If you want to reach a party by phone, you can leave the dialling to XtreemMachine®.
Not only will it dial the phone number, it will also determine whether the party called
has answered. If no one answers or the line is busy, the call will be retried later.

To make a phone call, select the Outbound→ Call menu item. This opens the Call
dialog menu window:

Here you can specify the Name of the party, the telephone Number and the Subject
of your call. If applicable, you can also take the name and number from the Phone
Book. Moreover, you can also define the Date and Time when the call should be
made, the number of Retries, and the Interval between attempts.

It goes without saying that two or more such call attempts can be activated at the
same time. XtreemMachine® will then display a message telling you which party you
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are connected with:

During this period the caller first hears the Welcome message (set as described
below), followed by the On Hold message. If the maximum wait period elapses,
XtreemMachine® will hang up and no further attempts will be made.

If you want to talk to the party, lift the receiver of your telephone and press the OK
button. The modem will then clear the line and you can talk on the telephone. A dia-
log menu window appears with information on the current connection parameters:

For this function to work properly your modem must be correctly connected to the
telephone line. You have to be able to talk on this line as soon as your modem hangs
up.

The necessary parameters can be specified in the Dialer menu window (Settings→
Dialer):
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7.2 Sending Voice Messages

XtreemMachine® is capable of sending a recorded voice message to one or more 
parties. To do so, it dials the desired phone number, waits for a connection to be set
up and then plays the message. The called party also has an opportunity to leave a
message with you.

If you want to send a voice message, select the entry for that message in a window
(e.g. the Inbound window) and click the Send icon or the File→ Send menu item. If
the voice message has not yet been recorded, you should likewise click the Send but-
ton. A window will appear, giving you an opportunity to record your message:
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You can also define the Time of Transmission, the Maximum Number of Attempts
and the Interval Between Attempts. Here too, of course, you have the option of 
choosing the telephone number from the Phone Book.
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8 The Fax Machine

8.1 Basic Settings

The basic fax mode settings include, among other things, the Fax ID and the Header
for the documents you fax.

The Fax ID is a unique code identifying your fax connection. Normally, it consists of
the phone number of your fax connection.

The Header is sent automatically at the top of every fax page. It contains the date and
time of day when the fax was sent, the fax ID, a freely selectable text, the current
page number and total number of pages in the document. Both parameters, Fax ID
and Header, can be specified via the Settings→ Fax menu in the Fax dialog menu
window:

Another basic setting enables you to print documents automatically upon receipt. The
number of Retries, number of Attempts and the Interval between attempts may also
be specified here.

8.2 Sending a Fax

In the ”Getting Started“ section we already told you how to send a fax from any
Windows application by simply running the print function. Here is a quick summary as
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a reminder:
First, create the document with any Windows application. To send the document,
print it with XtreemMachine® as printer. When the print operation starts, a dialog
menu window will appear in which you can specify the fax number you want:

By entering a starting time in the Date/Time area you open up the possibilities of
time-scheduled transmission. You can also define the number of Retries. When you
have finished, click the Send button, and your job will be carried out.

Transmitted documents are not lost forever; they are stored in the outbound fax
directory (Outbound→ Outbound Fax menu), giving you the possibility of transmit-
ting the documents again. You can also send them and other existing fax documents
(e.g. received faxes) directly to another fax connection. To do so, select the entry for
the document and click the Send button. This will open the Send Fax dialog menu
window:
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The name of the Fax File you want to send will appear in the display. You can now
specify the fax number or, as always, select it from the Phone Book.

In addition, you can also arrange for time-scheduled transmission by specifying a 
starting time in the Date/Time area. The default values for Retries can be adapted as
necessary.

8.3. Receiving a Fax

Normally, when XtreemMachine® takes a call it automatically recognizes when it is
dealing with a fax transmission. For additional support, the DataSwitcher can be
employed as described in the ”Answering Machine“ section. By specifying Fax in the
Answer Options dialog menu window (Settings > Answer Options menu), you can
switch off the answering machine or DataSwitcher and answer every call as a fax call.

8.4 Automatic Forwarding of Inbound Faxes

If you want XtreemMachine® to forward inbound faxes automatically to particular fax
numbers, select the Settings→ Fax menu item. The Fax dialog menu window will
appear. Now click the Forward Fax button:
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As with the callback settings described above for the answering machine, this win-
dow allows you to enter settings that define the Day and Time when the fax is to be
forwarded, and the Fax Number to which it should be sent (see also ”Remote
Control“ section). The At Other Times entry field can be used to enter an alternative
fax number to be called when there is no answer for entries 1 to 4.

The fax forwarding facility is toggled in the above dialog menu window using the
Enable Fax Forwarding check box. This can be done more quickly with the corre-
sponding button in the operator.

8.5 Remote Fax Interrogation

By ”remote fax interrogation“ we mean the option of sending all newly received fax
documents to another fax number by activating a remote control function. Unlike
automatic fax forwarding, this does not take place automatically, but only after a
command has been issued by remote control. You can determine the necessary set-
tings by clicking the Remote Control button in the Fax dialog menu window:

Normally you enter the fax number by remote control. The ”Remote Control“ section
explains how to start and run remote fax interrogation.

8.6 Fax Polling

One special fax function is fax polling, i.e. asking a remote fax system to send a fax
document to the calling machine. Normally, a fax machine sends a fax to the number
it has called itself. With fax polling, it calls another number, but receives a document
from that number.
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Many large airports allow weather reports and flight information to be polled from
their fax machines as a special service. The charge for the phone call is, of course,
borne by you as the caller.

”Fax polling“ should not be confused with ”fax-on-demand“. With fax polling, the
caller dials the remote station with his fax machine, having switched it to polling, and
immediately receives a fax in return. A fax-on-demand system is dialled with a normal
telephone. The caller enters DTMF tones to select one or more documents from a list
and receives the documents immediately thereafter. For further information, see the
”Fax-On-Demand“ section.

8.6.1 How to Poll Faxes

To poll faxes from another fax number, select the Outbound→ Poll Fax menu. The
Poll Fax dialog menu window will appear:

Enter the phone number of the fax connection you want to poll in the Fax Number
entry field, or select an entry from the Phone Book. XtreemMachine® will suggest a
file name for storing the document, but you can specify a different file name if you
wish. Click OK to confirm your entry, and XtreemMachine® will try to set up the
connection and poll documents from the source device.

8.6.2 Preparing a Fax for Polling

You can also offer the fax polling service the other way around and present a fax
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document to other people. To do this, select the Settings→ Fax menu and click the
Poll Fax button in the Fax dialog menu window:

Enter the name of the fax you want to send in the Document entry field, or click the
Select button to choose a fax from the existing list. The fax document you want to
send must exist in file form. Click the OK button, and your fax is ready for polling.

Tips on how to create these documents can be found at the end of the next section.
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9 The Fax-On-Demand System

Unlike fax polling, where there is a single document to be picked up automatically, a
fax-on-demand caller is able to select faxes from a list by remote control. These docu-
ments are then faxed to him.

9.1 Basic Features

9.1.1 Document Identification, Index List

Every document you prepare for fax-on-demand is given a three-digit number which
allows it to be selected by a caller. The system automatically creates an index list of
these numbers so that the caller will know which document is stored under which
number. This index list is made available as a document with the number 0. During
the greeting announcement, you should tell your caller that he or she can query a list
of available documents under the number 0.

9.1.2 Caller Requirements

It is essential that a caller is equipped to generate multiple frequency tones (MVF or
DTMF tones) with his or her telephone or remote control transmitter. Without them,
it is impossible to operate the fax-on-demand system.

If you decide to use direct transmission, callers will have to switch their fax machines
following the system prompt to the line on which they placed their call.

9.2 Conceptual Preliminaries

Before you present a list of documents to a caller, you should give some thought to
exactly what tasks you want the system to perform.

Do you want the system to function as an accessory to the answering machine (i.e.
do you want the caller to start the system from the answering machine by entering a
sequence of DTMF tones), or do you want it to start the moment the call arrives?

In this case, XtreemMachine® functions as a pure fax-on-demand system with the
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additional option of answering fax and BBS calls. However, the answering machine
and remote control facilities are switched off.

Do you want to employ user administration (i.e. a caller must first identify himself
with an ID and password before being granted access), or do you want every caller to
be granted access to the system? The advantage of the former is that access to the
documents can be precisely controlled. The drawback is that a caller first has to log
on with a user ID and password before he or she can gain access. Moreover, you have
to make this data known to the caller.

Another option is mixed mode. Here you employ user IDs, but give users without ID
and password an opportunity, say, to leave a voice message on the answering 
machine.

You should also define whether a caller has the right to select more than one docu-
ment.

Finally, you should consider whether callers are permitted to send documents at your
expense to a number they specify, or whether they can only obtain the documents
directly on the existing connection.

Remember, when you use callback every polling operation will be charged to you.

9.3 Setting Up the Fax-On-Demand System

9.3.1 Starting the System

You can decide whether the fax-on-demand system should be started on its own (i.e.
XtreemMachine® will immediately answer a call as fax-on-demand), or whether the
answering machine should be started first. This decision is made in the Answer
Options dialog menu window:

The Fax-On-Demand System9

99

User
administration

Selecting
two or more

documents

Send direct
or callback

!



To have the system start on the answering machine, you can set the necessary DTMF
tone sequence either in the main dialog menu window for fax-on-demand settings or
in the DTMF Tones dialog menu window. This latter menu window is reached by
clicking the DTMF Tones button in the Settings→ Answering Machine menu:

9.3.2 Basic Settings

The fax-on-demand system is configured via the Settings > Fax-On-Demand menu
item, which causes the following dialog menu window to appear:
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Here you can define which DTMF tones can be used to start the fax-on-demand
system from the answering machine. If you want to switch it off altogether, leave this
box blank, and the system will be unable to start.

9.3.2.1 Configuration Without User IDs

The Use User IDs check box allows you to toggle whether or not you want to require
user IDs. If you decide to work without them, you will be unable to click the User but-
ton. Instead, the Settings Without User IDs will be available. The operating mode
grants access to the fax-on-demand system to every caller, i.e. any caller can access
the documents of all groups (see below) unless they have been assigned passwords.

The Callback Permitted check box lets you enable a caller to leave his or her tele-
phone number. The selected documents will then be sent to this number when the
caller hangs up. Note that this involves telephone charges for you. The Callback
Numbers button allows you to prohibit the entry and use of certain phone numbers
(see below).

Unlike callback, the Direct Sending check box prompts the caller to prepare for direct
transmission once the documents have been selected. The system will then ask the
caller to start his fax machine.
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If you set the system to Direct Sending, the caller must be capable of switching his fax
machine onto the same line and receiving faxes on that line. This is often the case
with combined phone/fax machines.

You must mark at least one of the two check boxes, Callback Permitted or Direct
Sending. If both are activated, callers will be given a choice of which type of transmis-
sion they want to use. If you mark the Multiple Selection Permitted check box, callers
will be able to fetch more than one document. Every time the caller selects a docu-
ment he is asked whether he wants to select more.

Finally, you can also assign a Password for operation without user IDs. This password
protects your system from unauthorized access. It is queried the moment the system
is started. If you do not want to use a password, leave this box blank.

The last task handled through this dialog window is to configure some of the mess-
age files used in the fax-on-demand system. The announcements are always config-
ured in the subdialog menu window according to the related topic. Announcements
relating to document selection, for example, are found in the dialog menu window
for document settings. The main dialog menu window contains the announcements
for general use. These include:

Message Meaning

Welcome Played when the fax-on-demand system starts up.

Help Can be heard by the caller at any time in the session by 
pressing the * key.

Send Direct or Callback? Asks the caller whether he or she wants to receive the 
fax documents directly or via callback.

Start Fax Machine Asks the caller to start his or her fax machine.

Send After Hangup Tells the caller that the documents will be sent after he or 
she hangs up.

More Documents? Asks the caller whether he or she wants to select further 
documents.
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9.3.3 Documents

If you click the Documents button in the Fax-On-Demand dialog menu window
(Settings→ Fax-On-Demand) you will reach the dialog menu window that lets you
specify which documents you want to make available:

You are shown the list of currently available documents. The New, Modify, View and
Delete buttons allow you to edit the entries:
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Each document is assigned a number from 1 to 999. If you want to arrange them by
topic, you can put the documents into a Group. See below for further information on
the use of groups.

Each document may be assigned a password up to ten characters long. This enables
you to protect documents from unauthorized access. When the caller selects a pass-
word-protected document, the system will ask him to enter a password. The caller is
allowed three attempts to enter the correct password.

The Document Name entry field is used to enter the name of the fax file you want to
make available as a document. By clicking the Select button, you can also search for
this name in the list of currently stored documents. The document must be stored in
the directory for outbound fax files. Tips on creating documents can be found in the
like-named section of this chapter.

The Description entry field is used to write a description of the document contents.
This description will later appear in the index list. If you want the document to be
made available but not to appear in the index list, mark the check box Do Not Show
Document in Index List.

Once a document has been processed, the dialog menu window will reappear with
the list of available documents:
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The Preview button enables you to display the current index list and to change its
appearance.

If you want to have one or more pages of information prefixed to the documents you
choose to send, enter the relevant fax document in the Cover Page box.

The dialog menu window then configures four messages which the system an-
nounces to the caller for document selection purposes:

Message Meaning

Enter Document Number Asks caller to enter the number of the document.

Invalid Number Tells the caller that the number he or she entered is 
invalid or that he or she is not authorized to access 
the document.

Enter Document Password Asks the caller to enter the password of the docu
ment.

Invalid Password Tells the caller that the password he or she entered is 
invalid.

9.3.4 Groups

You have the option of putting documents into groups. Not only does this make the
index list easier to read, it also becomes possible to prevent certain users from ac-
cessing a group of documents, or to assign a password to a list of documents. Any
changes made to group settings affect all the documents within that group.

If you click the Group button in the fax-on-demand system’s Settings menu window
(Settings→ Fax-On-Demand) you will reach the dialog menu window that controls
group definition:
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You are shown ten entries for groups A to J, as well as the entry for the Standard
group. Documents not located in groups A to J will automatically be assigned to the
standard group. This group always contains the index list supplied by the system under
the number 0, but does not display the list itself.

You can add a description to any group. This description will appear in the index list in
front of the list of documents located in that group.

Each group can be assigned a password up to ten characters long. Once you have
defined a group password, all documents in that group are protected by the same
password. If a document in a password-protected group already has a password of its
own, the document password takes precedence, and the system will only query that
password during an access attempt.

9.3.5 Users

If you have decided to employ user IDs (by clicking the Use User IDs check box in the
fax-on-demand system’s Basic Settings dialog), you can reach the User Manager by
clicking the Users button in the Settings→ Fax-On-Demand menu:
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Here you are shown the list of specified users. You can change these entries with the
New, Modify and Delete buttons:

Every user is identified by a User ID up to ten characters in length. Further, every user
ID has a Password, which can also be up to ten characters long. If you are working in
user ID mode, both of these entries will be queried at the beginning of a session.

You can also assign a Name to each user. Upon request, this name will appear in the
log file of the fax-on-demand system. This gives you a quick overview of which users
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are assigned to which IDs, or which users have called which documents.

The ID and password may also be left blank. In this case, a caller must press the # key
when asked to present his or her user ID. If a user’s password entry is blank, he or she
will not be asked to present a password before using the system. In other words, the
# key obviates the need to enter a password.

Each user is assigned various privileges. The Callback, Direct Sending and Multiple
Selection settings have exactly the same meanings as the like-named settings in user
ID mode (see the ”Configuration Without User IDs“ section).

The Phone Number check box enables users to change their telephone numbers. You
can use this menu window to set up access for a user with callback privilege but with
no authorization to enter or change his or her phone number. In this case, the system
will use the phone number currently specified.

If the Phone Number box is left blank, the Modify Phone Number check box must be
switched on, and either Callback or Direct Sending must be activated. If both are
activated, the system will ask the caller which type of transmission he or she wants to
use.

You can also assign groups to a user. The user is then authorized to access these
groups. Every user is allowed to access the standard group. The check boxes for each
group allow you to permit access to an unlimited number of groups for each user.

When users query an index list, they are only shown the groups they are authorized
to access.

Once the user has been specified, the Fax-On-Demand: User dialog menu window
will reappear:
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Here you will find the announcements the system plays for user identification pur-
poses. These include:

Message Meaning

Enter User ID Asks the user to enter his or her user ID.

Invalid User ID Tells the caller that his or her user ID is invalid.

Enter User Password Asks the caller to enter his or her password.

Invalid Password Tells the caller that the password he or she entered is invalid.

9.3.6 Index List

If you click the Index List button in the fax-on-demand system’s Settings menu win-
dow (Settings→  Fax-On-Demand menu), you will reach the dialog box used to de-
fine the format of the index list:
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You can enter the title of the index list in the Header entry field. This text will then
appear at the top of every page of the index list. Moreover, there is also a setting for
a Footer to appear at the bottom of every page in the list.

The Show Group Name check box enables you to define whether the names of the
document groups should be displayed, and hence whether or not the documents in
the index list should or should not be arranged into groups.

You can check the current appearance of the index list by clicking the Preview button.

9.3.7 Callback Numbers

To avoid misuse of the system, e.g. to prevent callers from specifying numbers from
foreign countries, certain numbers can be enabled or disenabled. To reach the dialog
menu window where this is done, click the Callback Numbers button in the fax-on-
demand system’s Settings menu window (Settings→  Fax-On-Demand):
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Two lists of telephone numbers appear. Any phone number entered by a caller is, at
first, valid and permissible. The system now checks whether it matches any of the
numbers (or groups of numbers) in the Exclude list. If it does, the number is made
invalid. Nevertheless, you can have certain specific numbers declared valid by entering
them in the Include list.

Example:

Suppose the caller enters the number 0041-12345. Because it matches the „00+“
entry in the Exclude list (the „+“ stands for any arbitrary digit or digits), the number
will be declared invalid. From the „0041+“ entry in the second list, however, the
system discovers that transmission to Switzerland is permitted, and the number is
then enabled. You can change the entries in either list by clicking the New, Modify or
Delete buttons:
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Enter the desired sequence of digits in this entry field. You may use the plus sign ”+“
as a dummy, or ”wild card“, for any arbitrary sequence of digits, and the question
mark ”?“ as a dummy for a single digit. Further examples can be found in the Online
Help service.

Finally, the Fax-On-Demand: Callback Phone Numbers menu window configures the
announcements the system uses for entering telephone numbers. These include:

Message Meaning

Current Phone Number Tells the caller that his or her current telephone number is 
being read.

Change Phone Number? Asks the caller whether the telephone number is correct or 
should be changed.

Enter Phone Number Asks the caller to enter his or her telephone number.

Invalid Phone Number Tells the caller that he or she has entered an invalid tele-
phone number.

9.4 Tips on Creating Documents

Documents to be readied for fax-on-demand (or for fax polling) must exist in the form
of a file. Such documents can easily be created with the fax printer driver. First, write
your document in a Windows application, e.g. a word processor, and print it out on
the XtreemMachine Fax Printer Driver (see the ”Sending a Fax“ section in this same
chapter):
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In this case, however, rather than selecting a fax number (the document is not sup-
posed to be sent directly), click the Save As File button.

You will be asked to give the file a name. After entering the name, the document will
be stored under this name on your hard disk.
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10 BBS Operation

Normally, XtreemMachine® recognizes when a call is a BBS (mailbox) call. The
DataSwitcher may be used to support this feature. Furthermore, the Answer Options
menu window in the Settings→  Answer Options menu item allows you to answer
BBS calls exclusively.

10.1 External, Built-in or No BBS

You can grant a BBS caller access both to XtreemMachine’s built-in BBS and to an
external BBS from another manufacturer. Alternatively, you can deactivate the BBS
function altogether. The settings described below are found in the BBS dialog menu
window, which can be reached via the Settings→  BBS menu:

BBS Operations10

1010



10.2 No BBS

When you mark No BBS, XtreemMachine® will send the text given in Sorry, No BBS to
the remote station every time it receives a BBS call. Then it will hang up.

10.3 External BBS

The dialog menu window shown above presets XtreemMachine® to call an external
BBS under the name EXT_BBS.EXE. When a BBS call arrives, a modem/computer
speed of 38400 bits/sec is set and Data Mode is activated, i.e. a modem connection is
established. Only then does the external BBS start up. It must be set to accept the ex-
isting connection. The user’s guide to your BBS software explains how to do this for
the program you have chosen.

10.4 Built-in BBS

The built-in BBS system enables callers to send files to and from your system and to
write messages to you. You can set up various user privileges and thereby grant dif-
ferent privileges to different users. The built-in BBS is not as comprehensive in its fun-
ctions as powerful external BBS systems. However, its DOS-like user interface makes it
refreshingly easy to operate for novices. It is also sufficient to handle the remote
maintenance of your system.

10.4.1 How the BBS Works

When BBS callers reach the built-in BBS, they are first asked to enter their user name.
If the name is entered incorrectly three times in a row, or if the system does not reco-
gnize the name, the caller is sent automatically to the BBS’s message editor, where he
or she can leave a message. Then the system hangs up. If it recognizes the name, the
system then queries the user’s password. If this is entered incorrectly three times in a
row, the caller’s only option is, again, to leave a message.

When the password has been correctly entered, the caller is transferred to the com-
mand level. Here, using DOS-like commands, he or she can view directories, transfer
files, leave a message or perform similar operations:
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By assigning individual user privileges, you can allow or forbid each caller to use parti-
cular functions or to view particular directories. Inbound messages are displayed in
the Inbound window as mail.

10.4.2 Built-in BBS Commands

The following commands are permitted on the command level of the built-in BBS:

DIR Displays the contents of the currently active directory.
TYPE Displays the contents of a file (meaningful for text files only).
REN Renames an existing file.
CHDIR Changes the current directory.
MKDIR Creates a new subdirectory.
RMDIR Deletes an empty subdirectory.
RUN Runs a program.
UPLOAD Sends one or more files using the ZModem protocol.
DOWNLOAD Receives one or more files using the ZModem protocol. 
MAIL Leaves a message for the BBS operator.
EXIT,BYE,END Terminates the BBS and clears the connection.
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10.4.3 Adapting BBS Messages

The inbound, outbound and help messages of the built-in BBS can be designed at
your own discretion. To do so, start the BBS by clicking the BBS icon. Then select the
Settings→  BBS menu. The BBS Settings dialog menu window will now appear:

Place the cursor on the Help, Login or Logout entry field and click the Modify button.
This starts the editor with the current text for that particular box. Change the text as
desired, being sure to save your work before closing.

10.4.4 Command Execute Privileges

For each command, you can specify the minimum user level at which users are al-
lowed to execute the command. If a BBS caller has a lower user level than required
for a particular command, he or she will not be able to execute that command.

The up-dir entry is an exception to this rule. It is not a command, but permission to
switch to a higher directory than the one currently open. In conjunction with the opt-
ion of assigning a start directory to a user, this allows you to control access to parti-
cular areas of your hard disk.
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10.4.5 User Administration

If you want more users to have access to your BBS, select the Settings’  Users menu in
the BBS. This will take you to the User Administration dialog menu window:

To add another user, click the New button. This opens the Modify User dialog menu
window:

Place the cursor on the Name entry field and enter the user name. You can now de-
fine a Directory on your hard disk where the user should be placed when his or her
call arrives. Then assign the Password and Level.
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The Log I/O check box causes all user input in the BBS to be saved. This enables you
to retrace the activities of individual users, even at a later date.

Together with the entries you made in the command entry fields of the BBS Settings
dialog menu window, the Level allows the user to use some commands and prevents
him or her from using others. Thus, outside users should never be granted authority
to use the functions for deletion (DEL, RMDIR), renaming (REN) and directory creation
(MKDIR), as this might cause severe damage to your system (see also the Online Help
service).

Since you have the option of leaving a user entry’s Password entry field blank, you
may also, if you wish, set up a GUEST user. In this case, XtreemMachine® will not
query the password when a user name is entered, but will immediately send the caller
to the command level.

Whatever you do, make sure that such users have no authority to delete files or 
directories.

In either dialog box, the user level you enter may not be more than four digits long.

10.4.6 Testing the Built-in BBS

The built-in BBS can be started even when there is no connection to the modem. In
this case, it will accept input from the local keyboard as if it came from a caller. This
enables you to test the functions and settings of your mailbox. File transfer, of course,
is impossible, but the function is simulated when you enter the UPLOAD command.
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11 Remote Control

XtreemMachine® can be operated by remote control. All you need is a DTMF (Dual
Tone Multiple Frequency) transmitter or a telephone equipped to handle MVF dialling.

The XtreemMachine® remote control features are far more powerful than those of
ordinary answering machines. Unlike normal remote control, users are not only able
to query or delete inbound messages but can alter the settings in a wide variety of
ways. The spectrum extends from recording new greeting announcements or private
messages and running programs to changing settings and stored phone numbers.
Even the remote control access code can be changed by remote control.

A DTMF transmitter is the device that accompanies every normal answering machine
with a remote control feature. It can also be bought separately in any electronics
accessories store.

Unfortunately, the tones generated by most DTMF transmitters are often unrecogniz-
able to a modem. Conversely, more recent telephone sets are very well-suited for
remote interrogation. Nevertheless, we will continue in this manual to refer to DTMF
transmitters in the generation of tones.

The DTMF transmitter generates tones at the touch of a key. Each of these tones cor-
responds to a digit. The modem assigns them to the corresponding digits and reports
the results to XtreemMachine®. When we speak of entering a DTMF tone or a digit
below, we mean the transmission of these significant tones using a DTMF transmitter
or telephone.

11.1 Setting Up the Remote Control

To prevent unauthorized persons from accessing your system by DTMF transmitter,
you should click the Remote Control button in the Answering Machine dialog menu
window. The following dialog menu window will appear:
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Here you should enter your personal code number (up to 10 digits) in the Start
Remote Control entry field. This will later allow you to access XtreemMachine®.

In the dialog menu window shown above, you can also see the status report settings.
From the moment remote control is activated you will receive various items of prere-
corded information. The scope of this information can be set to any of three different
levels:

None Caller hears only the announcement that remote control has been 
activated.

Short Caller hears message with number of inbound calls, new messages and 
new fax documents.

Long Caller hears message with number of inbound calls, new messages and 
their duration, total number of all existing messages (including those al-
ready heard) and their durations, and number of new fax documents.

You can also define the order in which new messages are to be replayed and whether
the time the messages were received should be announced.

11.2 Starting Remote Control

To start operation by remote control, you have to send XtreemMachine® the personal
code number you entered in the remote control dialog menu window. This is done
either while the announcement is playing or during the message recording period.
The system will acknowledge the code number with a beep and play the status
report. The remote control functions are now at your disposal.
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11.3 Remote Control Functions

Due to their large number, the remote control functions are divided into two groups.
The first of these is normal functions that control the replay of inbound messages.
XtreemMachine® is set to this mode as soon as you start remote control.

If you press the asterisk key * in normal mode, you switch to the extended functions.
Here, too, the system will inform you that this has happened by playing an announce-
ment. Press the key again and you return to normal mode. Again, the system will
announce this in a message.

Once an extended function has been performed or aborted, XtreemMachine® always
returns to normal mode.

If eight seconds pass without input, a message will be played explaining the assign-
ment of keys to commands. If eight seconds again pass without input, remote control
will switch off automatically. An overview of remote control functions can be found
in Appendix A.

11.3.1 Normal Functions

The normal functions deal with the querying of inbound messages. The list below
describes the signals you need to send if you want to execute the corresponding 
functions:

Key Function

1 Play all new messages.
2 Play all messages, including old ones already heard.
3 Delete current message.
4 Go back one message.
5 Start replay of current message.
6 Go forward one message.
7 Start scan back, i.e. each message, beginning with the current one, is sampled

for about 3 seconds, after which the system skips back to the preceding 
message, samples it for about 3 seconds, and so on.

8 Stop.
9 Start scan forward, i.e. each message, beginning with the current one, is sam

pled for about three seconds, after which the system skips to the next 
message, samples it for about 3 seconds, and so on.
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0 Stop.
* Switch to extended functions.
# Exit remote control.

11.3.2 Extended Functions

The extended functions allow you to record new prerecorded announcements, to
change telephone numbers and other settings, and to run programs. They also let
you switch off the operator by remote control and query inbound faxes.

All these functions are voice-prompted, i.e. you are always told which actions or steps
you can take next. The exact operation of each function is explained in Online Help
under „Remote Control“. You will discover that the functions are very easy to oper-
ate. For that reason, we have decided not to describe their operation in detail here.

Any function can be aborted at any time by entering the digit zero. This, of course,
does not apply when the zero is entered as part of a telephone number. In this case
you must first terminate the digit entry.

11.3.2.1 Replay Settings („1“ Key) 

The current settings are announced by prerecorded message, including:

The answering machine is logically switched on/off.

User At Home is switched on/off.

Recording is switched on/off.

DataSwitcher is switched on/off.

Callback is switched on/off (with announcement of current callback number).

Fax forwarding is switched on/off (with announcement of current fax forwarding
number).

Call codes for private messages, including sample from each message.

Call codes for program calls.
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11.3.2.2 Change Prerecorded Messages (”2“ Key)

This function enables you to make new recordings of the basic announcements (with
or without the option of leaving a message) as well as private messages.

11.3.2.3 Delete All New Messages (”3“ Key)

This function deletes all new messages. It does not affect older messages already
heard, but only those messages received since the last remote control operation.

11.3.2.4 Change Phone Numbers (”4“ Key)

This function enables you to change the telephone numbers for callback, automatic
fax forwarding and remote fax interrogation.

11.3.2.5 Remote Fax Interrogation (”5“ Key)

If new fax documents have arrived, you can have them sent to you. One way of doing
this is by dialling the preset remote fax interrogation number. This number can also
be changed by remote control (see function 4, ”Changing Phone Numbers“).
Transmission occurs after remote interrogation has been terminated. Another way is
by direct transmission, i.e. over the current telephone connection. To do this, you
must have the capability of switching a fax machine to the open telephone line and
starting it after the user prompt.

11.3.2.6 Terminate Operator (”6“ Key)

This function terminates the operator after asking whether you really want to do so.
Unlike the Switch Off Answering Machine function, there is no way to reactivate the
operator, since as soon as it is switched off it no longer has control of the modem.

11.3.2.7 Change Settings (”7“ Key)

This function allows you to change the following settings:

The answering machine is switched on/off.

The user is (not) at home.

The caller’s option of leaving a message is switched on/off.
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The DataSwitcher is switched on/off.

Callback is switched on/off

Automatic fax forwarding is switched on/off.

11.3.2.8 Change DTMF Code (”8“ Key)

This function enables you to change the DTMF tones used for starting remote inter-
rogation, playing private messages, calling programs or serving as callback passwords.

11.3.2.9 Run Programs (”9“ Key)

This function enables you to start a program. In this case, the program is not selected
by its call code but by the position at which it was entered (Program Calls dialog
menu). This also makes it possible to run programs that do not have a call code and
therefore cannot be started during answering machine operations.

11.3.2.10 Normal Functions (”*“ Key)

Entering an asterisk restores remote interrogation to normal functioning.

1.3.2.11 Exit Remote Interrogation (”#“ Key)

This key is used to terminate remote interrogation.

11.4 Remote Activation

If your answering machine is turned off (e.g. via remote control function 7), inbound
calls are not answered at first. However, if the number of incoming rings exceeds the
Turned Off setting in the Answer Options dialog menu window (Settings→  Answer
Options menu), the call will be answered after all:
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This does not start the answering machine, however. Instead, after playing a user
prompt, XtreemMachine® waits for the remote control password to be entered. If the
password is correct, the answering machine is reactivated and remote control starts
so that you can check the settings immediately. If you don’t want to change any of
them, exit remote interrogation by pressing the ”#“ key or simply hanging up.
Remote control will then terminate automatically.
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12 Events

XtreemMachine® is very flexible in the way it handles timed events (jobs). This enables
you to time-schedule your faxes, send voice messages at particular times of the day,
or even to run as many programs as you want at a predetermined time.

12.1 Basic Information

Events are usually produced by the main ”control“ program, for example when you
want to call someone or send a fax. Some events are generated by the operator.
These include the callback event when a new message arrives.

12.1.1 Executing Events

Event execution is always performed by the operator. In other words, no event can be
started if the operator is not functioning.

12.1.2 Parameters

Each event contains a run time, i.e. a precise specification of the date and time of day
when it should be run. It also contains a setting for how many attempts should be
made to perform it and how long the interval between attempts should be. If the
maximum number of attempts is exceeded, the event will terminate. It will also 
terminate, of course, when it is successfully carried out.

Besides the type of event involved (e.g. send fax) and the requisite parameters (e.g.
phone numbers or file names), an event also contains a retry option. Here you can
specify whether a terminated event should be retried on a particular day of the week
or after a particular period of time has elapsed.

12.1.3 Types of Events

XtreemMachine® can performed the following events:
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Send fax

Poll fax

Callback

Call

Send voice message

Automatic fax forwarding

Remote fax interrogation

Run program

Change ring

Change call answer mode

Toggle modem

Toggle answering machine

Toggle user at home

Toggle record message mode

Toggle callback

Toggle fax forwarding

Toggle operator

Exit operator

Exit Windows

12.2 Generating and Processing Events

12.2.1 Automatic Event Generation

In most cases, events are generated automatically. For example, if you print a fax with
the fax printer driver for transmission purposes, the printer driver will automatically
generate the correct event and activate the operator. The operator will then start pro-
cessing the event when the start time has been reached.

12.2.2 Manual Event Generation

If you want to generate an event yourself, open the Outbound/Events window by se-
lecting the Outbound→  Outbound/Events menu item:
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Now select the File→  New menu item. You will see a dialog menu window asking
you to select the type of new event you want:

Select the type of event and click the Generate button. This opens a dialog menu
window where you can enter further information on the new event:

Enter the parameters needed for the event in the Parameters menu window. Which
parameters you need depends on the type of event involved. In the above example,
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you need to enter the phone numbers and the name of a fax file you want to send.

The Start Time area lets you specify when the event should start, how many attempts
should be made to start it, and how large the interval between attempts should be.

The settings in Repeat After Completion allow you to define whether the event
should be repeated after it has finished processing. The following options may be set:

Repeats will continue at regular intervals. In other words, repeating is continuous 
rather than unique.

The Delete Entry After Completion check box is used when you want to delete the
entry for the event once it has been run. In this case, an entry with Finished status will
not be shown.

12.2.3 Processing an Existing Event

Select an event for processing from the entries in the Outbound/Events window:
Double-click the selected entry or press the Enter key. This opens the Modify Event
menu window, and you can now process the event as described above.

You cannot modify events currently being executed by the operator.
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Repeat On

Repeat Every

Do Not Repeat

Enter the days of the week and a time of day. The event will be
repeated on the day of the week following the most recent run,
and at the specified time of day.

Enter a number of minutes. The event will be repeated when the
predefined time span has elapsed after the most recent event
termination.

The event will not be repeated.
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12.2.4 Event Status

The State box in the Outbound/Events window tells you whether an event has been
executed. Events currently being processed are identified by the Processing status.
These entries are indicated by red type. Active events waiting for execution are listed
with the Active status and are printed in green type. Events that have Finished are
printed in black.
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13 General Settings

These settings include specifications regarding the input/output devices and modem
you are using and the way XtreemMachine® should behave in certain situations. 

13.1 Modem

The Modem Settings menu window affects the model of the modem you are using as
well as its ports and initialization. It also contains information on the modem’s dialling
method and the telephone connection. You can call it via the Settings→  Modem
menu item:

Some of these settings were already made by the Setup program. Changes in this dia-
log menu window are rarely necessary. Be cautious in the changes you make, for they
can considerably impair XtreemMachine’s performance. In the worst case, you will
have to reinstall the XtreemMachine program.

The ComPort entry lets you define which modem port will be used. If you want to
operate XtreemMachine® without a modem, deactivate the Modem Installed check
box.

Similarly, you can also change the data of your Telephone Connection, including the
type of Connection (Main Subscriber or PABX Extension), Dialling Type and, if ne-
cessary, a Dial Prefix for operating a private automatic branch exchange (PABX).
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Further information can be found in your PABX manual.

13.2 Voice Settings

13.2.1 Default Equipment Settings 

You can define which equipment should ordinarily be used to record or playback
voice files. Select the Settings→  Voice Settings menu item:

For recording purposes you can make use of the sound card (assuming one is instal-
led in your system), the telephone line and the built-in microphone on your modem.

For playback purposes you can choose between the sound card or telephone line and
the loudspeaker on your modem. The kik modem package includes an external loud-
speaker/microphone attachment.

13.2.2 Recording and Playback Specifications

To specify the file formats to be used for recording and playback, click the Further
Settings button in the Voice Settings dialog menu window:
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Further information on these settings can be found in the Online Help service.

13.2.3 Analyser

The analyser is an XtreemMachine® program unit that enables improved distinction
between voice, fax and mail messages and offsets shortcomings in the voice mode of
your modem. At the time this manual went to print, XtreemMachine® was the only
commercially available program with this capability.

In the factory configuration the analyser is switched off. To configure it, click the
Analyser button in the Voice Settings dialog menu window:

The ”Analyser“ entry in the Online Help service explains how it actually works,
whether you should use it, and how you can configure it.
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13.3 System Settings

The system settings fall into three categories: main program settings, operator set-
tings and program definitions.

13.3.1 Main Program Settings

To reach these settings, select the Settings→  System Settings menu item:

This is what the entries mean:

Settings
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Confirm
Deletion/Overwriting

Save Desktop On Exit

Always Announce Time

Before a file is deleted or overwritten you are asked
whether the operation should be carried out.

When XtreemMachine® terminates it automatically saves
the layout of the open window. This layout is automatical-
ly loaded when you restart the program.

When you have new messages played back with the Play
New Messages†function, the time of day is announced
with each message. Otherwise this will only happen for
calls where the caller hangs up without leaving a message.



Log Window

Here you can arrange for the contents of the log window to be saved. They are saved
in the XTM.LOG file in the XtreemMachine® main program. The amount of informat-
ion in the log window can be specified as Low, Medium or High.

Editor

This is where you specify a text editor to be used for viewing mail. The default value is
MS-Windows Notepad.

13.3.2 Operator Settings

After clicking the Operator icon in the system settings dialog, you will be able to
modify the system settings of the operator:

Keyflash

The operator indicates that new messages or calls have arrived by flashing the scroll
lock LED on the keyboard:

General Settings13
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List New Messages First

List New Events First

Defines the order in which the files are listed.

Defines the order in which the events are listed in the
Outbound/Events window.



Bring to Foreground On...

Return to Background

Miscellaneous
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For New Messages

For New Calls

Keyflash is switched off.

If new messages have arrived, the scroll lock LED on the
keyboard will flash. The length of the flashing period
depends on the number of messages received.

If calls have arrived, the scroll lock LED on the keyboard
will flash. The length of the flashing period depends on
the number of calls received.

Recapture Modem After

Delete Events After

If the modem was released in the operator, the operator
will try to recapture control of the modem after the inter-
val specified here (see also ”Operator“ chapter).

Here you can specify whether finished events should be
deleted, and if, so, after how long a period.

Incoming Call 

Any Action

Start As Icon

The operator window will be switched to the foreground
as soon as a call arrives.

The operator window will be switched to the foreground
for every action.

Once an action has finished, the operator window will
switch to the background.

Never

Always

The operator will not switch to the background.

Once an action has finished, the operator window will
always switch to the background.

If No New Messages Once an action has finished, the 
operator window will switch to the background provided
there are no new messages.



13.3.3 Starting Programs

If you want to set up programs to be started by XtreemMachine® or the operator, sel-
ect the Start Programs button from the System Settings window:

By clicking the New button, you can enter a program in the list so that you can reach
it later via the Start Programs icon:

Enter the Program Title of the program you want to start and select the associated
Program Name. By clicking the Select button, you can have a directory list displayed in
order to help you find the file more easily. The Release Modem check box tells the
system that the program you called needs to access the modem.
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13.4 Directories

Using the Settings→  Directories menu item, you can define the directories where
XtreemMachine® should search for or store particular files:

The titles of the input lines tell you which files will be stored in which directories.
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14 The Operator

The XtreemMachine® operator is the heart of the program package. It is responsible
for executing all actions, including making, receiving and processing calls, sending
faxes, and sending voice messages.

14.1 The Operator Concept

Besides handling all modem activities, the operator functions as a sort of control
panel. Settings that frequently have to be changed (e.g. Release Modem, User At
Home) can be quickly toggled via a toolbar. Moreover, it can be used to call the main
program and to play all new messages. Not only does it display all inbound calls, it
also tells you whether any new messages have arrived.

The operator window has deliberately been kept small. We had to strike a comprom-
ise: it has to give you a quick overview of important information, but oversized win-
dows are a nuisance when you are working with other Windows applications and the
operator is waiting for a call in the background. Moreover, we wanted to make it fast
and simple to operate.

Since the main program lists inbound messages and carries out all configuration
assignments, the operator needs very little RAM.

14.2 Running the Operator

The operator can be started from the MS-Windows program manager. Just click the
Operator icon in the XtreemMachine program group.

It can also be activated via the Operator button in the main program.

Like the main program itself, the operator cannot run more than once at any given
time. If you try to call it again after it has already been started, you will only activate
the operator that has already been loaded.
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14.3 Operator Screen Format

Once you have started the operator the following display will appear:

You are shown the present status of the system, in this case ”Modem released“. The
lower edge of the window has counters for the inbound calls and BBS connections as
well as new messages, subdivided into voice, fax and mail.

When a call or any other action is carried out, the five-line entry field tells you what
sort of operation is involved and gives you its current status. For example, when you
send a fax, the entry field might look as follows:

This shows you which messages have been played or tells you the status of the fax
transmission operation. Once an action has finished, the operator will return to the
above screen format.
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14.4 Using the Operator

The operator can be handled either via the toolbar or the keyboard. The list below
shows you which icons are available, followed by a brief description and a key com-
bination for keyboard operations:

Open Help (F1)

Start main program (CTRL+V)

Start terminal program (CTRL+T)

Access America Online (AOL)

Access T-Online 

Access CompuServe

Start Internet Explorer

Start a program

Call (F5)

Play new calls (F2)

Release/Occupy modem (CTRL+O)

Toggle „User At Home“ (CTRL+W)

Toggle callback (CTRL+R)

Toggle fax forwarding (CTRL+F)
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Take an inbound call (F9)

Cancel a current action (ESC)

These instructions can be classified into two groups:

14.4.1 Commands

The commands include Start Help and Call Main Program.

All new calls can be played back directly via the operator.

Other commands are Call Terminal Program and Start Program.

To allow the operator to function as a switchboard, it is also possible to make a call
by clicking an icon.

The Answer icon allows you to answer an inbound call manually. This function can be
used when a call arrives and you want to respond before the specified number of
rings has been reached.

If there is no inbound call, manual answering via the Answer icon will not function.
Regulations regarding the use of modems prohibit them from keeping a telephone
line engaged when there is no call.

The Stop icon lets you abort any current operator activity. The operator responds to
this instruction immediately. All the same, with some operations it may take a while
before they are actually aborted. This is necessary, for example, in the case of fax for-
warding so that the connection can be cleared down properly.

14.4.2 Toggle Icons

Six settings can be easily toggled from the operator. Five of them are also reachable
from the main program. The sixth one determines whether the operator has control
of the modem.
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The operator allows you to toggle the following parameters:

Release or occupy modem

Toggle the ”User At Home/Not At Home“ status

Toggle callback mechanism

Toggle automatic fax forwarding

Because you have the option of taking control of the modem away from the oper-
ator, and thereby releasing the modem, you can use other telecommunications pro-
grams that need to access the modem. It need hardly be mentioned that a modem
can only be available to one program at any given time. But you do not have to exit
the operator if you want to use other programs.

Once you have finished working with the other program, return control of the
modem to the operator.
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15 The FaxViewer

15.1 Starting the FaxViewer

Once you have started the FaxViewer, the following screen will appear:

It automatically begins by displaying a document if a fax document has been selected
in the main program and you have issued the faxview command. The title bar shows
you the file name of the displayed document.

15.2 Operating the FaxViewer

15.2.1 Changing the Display Format

There are several different ways of changing the display format of a fax document.
You can do this either by clicking the icons in the right-hand toolbar or by selecting

The FaxViewer15

1515



1515

The FaxViewer15

entries in the View menu.

Here are the icons and key combinations of the FaxViewer:

Expands the format of the displayed document (”+“ key)

Reduces the format of the displayed document (”-“ key)

Displays the document at 25% of its original size.

Displays the document at 50% of its original size.

Displays the document at 75% of its original size.

Displays the document at its original size.

Displays the document using the full width of the window.

The entire page of the fax document is displayed.

Rotates the document display 180 degrees (CTRL+R).

15.2.2 Page Breaks

A fax document may consist of more than one page. The Previous Page or Next Page
icons enable you to display a different page.

To specify the number of the page you want to have displayed, use the Page→  Go To
Page menu command:



These commands, of course, cannot be executed if the fax document consists of a
single page.

15.2.3 Printouts

To print the displayed fax, select the File→  Print menu command or click the Print
icon. A dialog menu window will open, and you can specify the pages you want to
have printed:

The following options are allowed when printing a fax document:

In addition, you can also specify the number of Copies you want and whether these
copies should or should not be sorted.

15.2.4 Exporting Fax Pages in Graphic Format

To process received fax documents further using other Windows applications, export
them as fax pages.

15.2.4.1 File Export

Select the File→  Export menu item. A dialog menu window will open, and you can
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Pages From ... To ...

All pages in the document are printed.

Only the page currently on display is printed.

The specified pages are printed.



enter the name of the file where you want the page on display to be saved. In addit-
ion, you can also select the type of file you want. The choice is between Microsoft
Bitmap and ZSoft PCX format.

The exported page is always the one currently displayed, and always in its current
screen format. This enables you to define the size of the exported graphics.

15.2.4.2 Copying to the Windows Clipboard

The Edit→  Copy menu item allows you to save the currently displayed page to a
Windows clipboard. As a rule, other Windows applications provide a menu item
Edit→  Insert allowing you to insert the clipboard contents in the data you are edit-
ing.

The page copied to the clipboard is always the one currently displayed, and always in
its current screen format. This enables you to define the size of the exported graphics.

15.2.5 Deleting Fax Documents

The File→  Delete and File→  Delete & Exit menu items can be used to delete a docu-
ment. The latter, and the Delete&Exit icon, not only delete the file but terminate the
FaxViewer as well.
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16 The Terminal Program

16.1 What is a Terminal Program?

A terminal program enables you to set up a data connection to another computer or
BBS system. The terminal program then takes on the task of transmitting characters
from your computer to the remote station and displaying received characters on your
screen. It also ensures secure file transmission.

16.1.1 Display Format

If received characters were to be displayed without their format, color and original
placement, the result would be completely chaotic and virtually impossible to read.
That is why particular characters or groups of characters - so-called ”control charac-
ters“ - are used to transmit this information. They ensure that the remote station can
transmit color information and is able to control the placement of each character on
your local screen.

Terminals differ in the way they define control characters. As so often happens, there
are several standards currently in use. The XtreemMachine® terminal program is able
to emulate TTY Terminals, ANSI-BBS Terminals (a subgroup of VT-100 sequences) and
Avatar Terminals.

Wherever possible, always use the ANSI-BBS terminal emulation.

16.1.2 File Transfer

The second major task of a terminal program is to ensure that files are transferred
correctly. It has to be able to recognize and correct errors resulting during a file trans-
fer operation, or, failing that, to retransmit the files correctly.

File transfer protocols are employed to ensure that this happens. The sender breaks
down the transmitted data into smaller units called ”blocks“, calculates a checksum
for each unit and sends the block together with its checksum to the remote station.
The receiver receives the block, calculates the checksum on its own and compares the
results with the one it has received. If the two values are identical, the unit was trans-
mitted without errors and the receiver stores the block. If not, the receiver reports this
fact to the sender. The latter then retransmits the unit until the transmission process
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is complete without errors.

If errors are reported during a protocol transmission, this does not mean that the
received data is corrupt. As already mentioned, errored blocks are retransmitted. The
error indicator merely registers the number of retransmitted blocks.

There are various transmission protocols currently in use. The terminal program has
XModem, XModem1K, YModem and ZModem at its command.

Further information on the differences between the various protocols can be found in
the Online Help service under „Protocols“.

Wherever possible, use the ZModem protocol.

16.2 Starting the Terminal Program

The terminal program can be started from the main program, the operator or the
Windows program manager:

At first, the window remains empty until a connection is set up. The lower edge of
the windows tells you whether you are connected with a remote station, and if so,
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for how long. It also tells you which interface parameters are currently in effect (in the
above case ComPort 2, 8 data bits, no parity and 1 stop bit) and which terminal 
emulation you happen to be using. At the far right you can see the results when the
name of the modem was interrogated (in our example ”AC/V34“). This information
allows you to recognize which modem you are currently using.

16.3 Operating the Terminal Program

The terminal program is operated in the same way as all other program units, i.e. 
either directly via the keyboard, via the menu bar, or via the toolbar. Here is a brief
description of the icons:

Open Online Help for the terminal program (F1)

Start setting up a connection (ALT+A)

Clear down a connection (ALT+A)

Send file (PgUp key)

Receive file (PgDn key)

Send text file (ALT+T)

Run script file (Alt+F)

Debug script file (ALT+U)

Create/edit script file (ALT+E)

Open/close achive file (Alt+L)

Print screen (Alt+P)
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16.4 Setting Up and Clearing Down Data Connections

16.4.1 Setting Up a Data Connection

To set up a data connection, select the File→ Dial menu item or click the Dial icon. A
dialog menu window will appear. Enter the phone number of the called party in this
box under Called Party:

If your modem is connected to an extension, you do not have to prefix the digits
necessary to receive an outside line. The terminal program will do this for you auto-
matically. If you want to make an internal call on the telephone, activate the Internal
check box by clicking it with the mouse. The terminal program will then suppress the
dial prefix.

You can, of course, always take the phone number from the Phone Book:

As soon as you press the Dial button in the Dial menu window, connection setup will
begin:
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A counter starts running. If no connection is set up during the 90 seconds displayed
by the counter, dialling will be aborted with an error message. Otherwise, the status
dialog terminates and you can start communicating with the called party.

The lower left edge of the terminal window shows you how long you have been
connected with a called party.

16.4.2 Clearing Down a Data Connection

Data connections are cleared down by simply selecting the File→  Hang Up menu
item or clicking the Hangup icon in the toolbar. After a warning, the modem will
hang up and the connection is terminated.

16.5 File Transmission

16.5.1 Sending Files

If you want to send a file, prompt the BBS system you are connected with until it asks
you to start transmission. The way this happens depends on which mailbox system is
being used. As transmission protocol, choose either XModem, YModem or ZModem.
Following the prompt from the called party, select the File→  Send File menu item or
click the Send File icon:
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Now specify the name of the file you want to send or press the Select button to
obtain a list of file names. Make sure that you have set the correct protocol. Now
click the Send button to start the transmission:

16.5.2 Receiving Files

To receive a file, select the file you want to receive from the called party. The system
will then ask you to start the transmission process. If you have selected the ZModem
protocol and activated the automatic receiving function (see below), transmission will
start automatically. If not, you have to start the procedure manually by selecting
File→  Receive File in the menu or clicking the Receive File icon:
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After making sure that you have selected the correct protocol, start the transmission
process by clicking the Receive button:

The directory for inbound files in the internal BBS will be suggested as a target 
directory.

16.6 Transmitting Texts

Many BBS systems give you an opportunity to write messages to other users. To save
telephone charges, you can write these messages before setting up the connection
and send your ready-made text while the connection is active. Generally, BBS systems
provide an editor for the input of messages. In most cases this editor is unable to
receive messages via a transmission protocol. However, the terminal program offers
you the possibility of sending a text character by character to the called party. To the
receiving party, it looks as though you were typing the text very quickly by hand. In
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fact, the characters are transmitted directly from the ready-made file.

To transmit a text, select the File→  Send Text File item from the menu or click the
Send Text File icon:

Select the correct file in the dialog menu window that now appears, and click the 
OK button. The text will now be sent to the called party:

16.7 Terminal Program Settings

16.7.1 Setting the Terminal Emulation

To set the terminal emulation you want to use or the characteristics of the emulation
currently in use, select the Settings→  Terminal menu item:
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Besides the list of Terminal Emulations (TTY, ANSI-BBS and Avatar), there are also fur-
ther settings at your disposal. The Online Help service will tell you the effect of each
of these settings.

16.7.2 Setting the File Transfer Protocol

To change the default settings for file transfer, select the Settings→  Protocols menu
item:
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If the file you are receiving is already stored in your system, it will be overwritten
when a new file arrives. This default setting can be changed by toggling the
Overwrite Files switch. The inbound files will then be stored in a different file.

With the ZModem protocol, you can choose whether to use enhanced error correct-
ion (CRC 32 Permitted), whether to resume an aborted transmission (Transmission
Crash Recovery) and whether to activate Automatic Download, i.e. the terminal will
start protocol transmission automatically as soon as it recognizes that a transmission
is underway.

For sending text files, you can define whether to Send 7-Bit ASCII only, which End-Of-
Line control character to use (CR, LF or both), and whether there should be a Delay
after a character or line is sent.

16.7.3 Setting the COM Port

To change the parameters used to address the serial interface, select the Settings→
COM Port menu item:

Besides the settings for DTE Speed, you can also vary the number of Data Bits, the
type of Parity used and the number of Stopbits. These last three settings indicate
which data format the modem is to process. The setting ”8-N-1“ means that eight
data bits are sent, there is no parity bit, and a stop bit is sent after every eight data
bits. This is a default setting suitable for virtually all BBS systems.
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You can also use this dialog menu window to specify the Flow Control, i.e. the way
the modem tells the computer that it cannot receive data at the moment. The default
setting is hardware flow control via the RTS and CTS control lines.

You should always set the interface rate to a higher value than the maximum line
speed (modem-to-modem; connection speed) since data compression may entail the
need for higher transmission rates (modem-to-PC).

16.8 Script Function

A description of the script function with examples can be found in the Online Help
service.
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Appendix

A Overview of Remote Control Functions

Normal functions:

Key Function

1 Play new messages
2 Play all messages
3 Delete current message
4 Go back one message
5 Start playback
6 Go forward one message
7 Start scan back
8 Stop playback
9 Start scan forward
0 Stop playback
* Switch to extended functions
# Exit remote control

Extended functions:

Key Function

1 Play status
2 Change prerecorded messages
3 Delete new messages
4 Change numbers
5 Start remote control
6 Exit operator
7 Settings
8 Change DTMF codes
9 Program calls
0 Normal functions
* Normal functions
# Exit remote control
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B Deinstalling XtreemMachine®

Before you start deinstalling XtreemMachine, make sure that you will not delete any
important messages, fax documents or mail. If necessary, save these items before you
start. To deinstall XtreemMachine from your system, proceed as follows:

1. Exit MS-Windows.

2. Delete all files located in the XtreemMachine main directory or in the subdirectories
beneath the main directory. Then remove the subdirectories themselves. Finally,
remove the XtreemMachine main directory.

3. After installing the fax printer drivers, delete the files XTMPRN.DRV, XTMPRN.HLP
and XMFAX.DLL from the MS-Windows system directory (SYSTEM).

4. Now edit the WIN.INI file of MS-Windows by deleting the following entries:

the line XtreemMachine=xtmprn,COMx:,15,45 in the [PrinterPorts] section

the line XtreemMachine=xtmprn,COMx:in the [devices] section

the entries Paper, FineResolution and XTMPath in the [XtreemMachine] section

if the [Windows] section contains the entry device=XtreemMachine ,xtmprn 
,COMx: delete this entry as well. In this case, you will have to install a new 
default printer in the MS-Windows system controller.

5. If RHSICOMM.DRV was installed under Windows 3.1 or 3.11, change the
comm.drv=rhsicomm.drv entry in the [boot] section of the SYSTEM-INI file to
comm.drv=comm.drv.

6. If RHSICOMM.DRV was installed under Windows 3.1, delete the RHSICOMM.DRV
file from the MS-Windows system directory (SYSTEM). 

Caution: Make sure that you have carried out item 5.

7. Start MS-Windows.

XtreemMachine® has now been completely removed from your hard disk.
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C Support

We offer a comprehensive service and support package, including a bulletin
board where you will find continuously updated drivers, interesting informat-
ion, and tips and tricks for XtreemMachine®. You can also ask questions there
and swap information with other XtreemMachine users.

To avoid possible misuse, we can only grant access to our support services to
our own customers.

If you want to take advantage of our support services, please specify your serial
number or keep it ready to show on request. You will find your serial number
on the label of the first installation diskette or on the CD.

Written questions can be sent to:

Diamond Multimedia
610 Wharfedale Road, Winnersh Triangle
Wokingham, Berkshire, RG41 5TY, UK

Support: +44-1189 4444-44 (Tech Support)
Fax: +44-1189 4444-01

BBS: +44-1189 4444-15 (V.34 modem)

Internet: http://www.diamondmm.de
ftp://ftp.diamondmm.de
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